
Action! Command Index

Use the scroll bar to see entries not currently visible in the Help window.    To learn how to use Windows
Help, press F1 or choose Using Help... from the Help menu.

Click a command to see a description of it.    A command followed by an ellipses (...) includes a 
description of the dialog box associated with that command.
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            Import Presentation...  
            Export...  
            Printer Setup...  
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Control Menu Commands
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Scene Menu Commands
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     Scene List  

Chart Menu Commands
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     Data Window  
     Data Motion  
     Chart Options...  
     Axis Options...  
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Help Menu Commands
     Commands...  
     Using Help...  
     About Action!...  



New Command

Opens a new, untitled Action! presentation window in scene view, and displays the Tool Palette and 
Control Panel.    You can only have one presentation window open at a time.    To name the 
presentation, choose Save or Save As... from the File menu.

By default, Action! creates a new presentation with 1 scene.    You can change the default number of 
scenes using Preferences... on the Edit menu.



Open... Command

Opens a saved Action! presentation or stationery document.    If you have made changes to the current 
presentation when you choose this command, Action! prompts you to save your changes before 
displaying the Open Presentation dialog box.

File Name:
Type a document name or select a name from the list.    Action! opens presentations with the .ACT 
extension and stationery with the .STA extension.

Preview 
Displays a compressed view image of the first scene in the presentation or stationery document.    You
can change the previewed image using Set Preview on the Scene menu.

Open 
Opens the selected document.    A stationery document opens as an untitled copy of the original 
document.

The presentation opens in compressed view if the "Open in Compressed View" option is selected in the 
Preferences dialog box.    Compressed View displays all the objects in each scene at their Hold 
positions.



Load Template... Command

Loads a template into the current presentation and applies it to one or more scenes.    You can apply the
template to all scenes, one or more selected scenes, sequential scenes, or load it and apply it later.    To
apply the template to selected scenes, select the scenes in the scene sorter before choosing this 
command.    The template you apply replaces the previous template.

Action! first displays the Load Template dialog box.    When you click Open, Action! displays the Apply 
Template dialog box.

Load Template dialog box 
Lists the Action! templates (with file extension .TPL) that are in the current directory.
File Name:

Type a document name or select one from the list.
Preview

Displays a compressed view image of the selected template.    You can change the previewed 
image using Set Preview on the Scene menu.

Open
Loads the template and displays the Apply Template dialog box.

Apply Template dialog box
Specifies where presentations to insert templates in the presentation.
Template File:

Displays the name of the template that has just been loaded, and lists all templates loaded in the 
current presentation.

To:
All Scenes

Applies the template to every scene in the presentation.
Current Scenes

Applies the template to the scenes you selected in the scene sorter or to the current scene in the 
presentation window.

From Scene
Applies the template to a sequential number of scenes.

Apply Later
Loads the template without applying it.    To apply it later, select the scene(s) in the scene sorter to
which you want to apply the template, and choose Edit Scene... from the Scene Menu.    Choose 
the template from the template list in the Edit Scene dialog box.

OK
Applies the template.



Save Command

Saves the current presentation, replacing the previous version saved under the same name.    The first 
time you choose this command for a new presentation, Action! displays the Save Presentation dialog 
box so you can name the presentation.

File Name:
Contains the file name. Use this box to enter a file name or select a name from the list.

File Type:
Lists the formats in which you can save the presentation.

Document
Saves the presentation so that it can be opened and played by Action! Document files have the 
extension .ACT.
Stationery
Saves the presentation so that it can be reopened and edited but leave an original version of the 
presentation intact.    Stationery files have the extension .STA.
Player
Saves the presentation so that it can be played by the Action! player. Player files have the 
extension .ACP.



Save As... Command

Saves the current presentation under a different name, in a different location, or in a different format. 
Use Save As.. to save a presentation that is still untitled.

File Name:
Contains the file name. Use this box to enter a file name or choose a name from the list. 

File Type:
Lists the formats in which you can save the presentation.

Document
Saves the presentation so that it can be opened and played by Action! Document files have the 
extension .ACT.
Stationery
Saves the presentation so that it can be reopened and edited but leave an original version of the 
presentation intact. Stationery files have the extension .STA.
Player
Saves the presentation so that it can be played by the Action! player. Player files have the 
extension .ACP.



Save Template As... Command

Saves all the objects in the current template view as a template file, with a .TPL extension.    Action! 
saves any background image and IN Transition you set for the current template.    Give the template a 
descriptive name to help you remember its contents.



Import... Command

Imports a graphic, Macromedia Director movie, sound, or Windows palette into the current scene or 
template. If the Data Window is open, imports data from the Clipboard. You can also import a movie or 
sound by clicking the Action tool or the Sound tool in the Tool Palette, and then clicking in the 
presentation window.

File Type:
Lists the file types that Action! can import.

.DIB, .BMP Windows bitmap graphics

.WMF Windows Metafile graphic

.PAL Windows palette

.WAV Microsoft WAVE sound

.MID MIDI
CD Audio Compact Disc sound
.MMM Converted Macromedia Director 2.0

or 3.0 movie

Before importing a CD Audio sound, you must have a CD player attached to your computer.    Before 
importing a Director movie, the movie must be converted on a Macintosh computer using the Gaffer in 
Macromedia Windows Player.

Because digitized (.WAV) sounds require lots of memory, you might want to use .WAV sounds for short 
(object) sounds and use .MID or CD Audio sounds for longer (scene) sounds.

If the Data Window is open, lists the types of data files that Action! can import.

.WK1 Lotus

.WKS Lotus

.TXT Space separated

.TXT Tab separated

.CSV Comma separated

.XLS Excel

.DBF dBase

File Name:
Displays the name of the file to import.    Type the file name or choose it from the list.

Preview
Displays an image of the selected file or plays the selected sound. (Preview is not available if the 
Data Window is open.)

Use Palette
When checked, uses the palette associated with the selected graphic file or movie (Use Palette is not 
available when the Data Window is open.).    An imported graphic's palette is then available for use in 
any Action! scene or template.    (An imported movie's palette is not available for use in other scenes 
or templates.)    The scene uses the graphic's or movie's palette when the graphic or movie appears in
the scene.    For best results, import movies that use the Macintosh system palette.    The Macintosh 
system palette matches Action!'s default palette, except for the bottom 16 colors in the Action! palette.

Import
Imports the selected file.    An imported graphic or movie is visible in the current scene and in the 
Timeline.    An imported sound is visible only in the Timeline.    An imported palette becomes the 
current palette.



If you import a movie, you may need to play the movie and lengthen its duration in the Timeline to 
make sure that the entire movie plays in the scene.    To crop the movie, select it and drag one of its 
handles to decrease the size of the rectangle in which the movie plays.

If you import a sound, Action! displays the Sound Edit dialog box so you can specify the sound's 
duration in the scene.    If you import a CD Audio sound, click the CD Audio button in the Sound Edit 
dialog to display the CD Audio Editor dialog box.    Use this dialog box to control the CD player and to 
create the CD Audio segment.    To create the segment, specify a start time and track number, and an 
end time and track number.    Click Preview to preview the CD segment.    When you click OK, Action! 
returns you to the Sound Edit dialog so you can specify the sound's duration in the scene.

If you import data, Action! starts inserting data at cell A1 in the Data Window..



Import Presentation... Command

Imports presentations from external applications. Imported presentations must be in .WMF format.

File Name:
Lists the name of the file to be imported. Choose a file directory and name from the directory and 
file lists, or type the file name in the File Name box.

Import Options
Specifies how the file is imported.
Import as One Metafile

Imports the presentation in its original form
Separate Text Only

Extracts the text from the presentation, and makes the text items individual objects that you can 
assign action, sound, and links. The background remains in .WMF format.

Separate All Objects in Metafile
Separates the presentation into its individual objects, which lets you apply separate action to 
each object.

Insert Scene Options
Specifies where to insert the imported files. Action! treats each file as a separate scene, and inserts 
the scenes according to their order in the list of file names. 
At Beginning

Inserts the scenes at the beginning of the presentation.
After Current Scene

Inserts the scenes after the currently selected scene.
At End

Inserts the scenes after the last scene in the presentation.



Export... Command

Saves a snapshot of the current scene to a file that can be opened by other Windows graphics 
applications.

File Type:
Lists the file types that Action! can export.

.DIB Windows bitmap graphics

.WMF Windows Metafile graphic

File Name:
Enter the file name you want to assign to the exported file.

Export
Exports one or more snapshots of the current scene to one or more snapshot files of the specified file 
type in the current directory.

Start Time:
Specifies the time in the current scene at which Action! begins exporting a snapshot of the scene.    
This is typically the time at which objects first appear in the scene.

End Time:
Specifies the time at which Action! stops exporting a snapshot of the scene.    This can be any time 
during the scene, up to and including the scene's end time.

Every:
Specifies how often between the Start Time and End Time Action! creates a snapshot of the scene.    
Action! saves each snapshot to a separate file, using the first five characters of the specified file 
name, followed by a sequential number, e.g., LUNAC001.DIB, LUNAC002.DIB.



Printer Setup... Command

Displays the Microsoft Windows Printer Setup dialog box.    Use this dialog box to choose or change 
print options.    For more information, click Help... in the Printer Setup dialog box or refer to the Microsoft
Windows User's Guide.



Print... Command

Prints the current presentation using the printer specified by the Printer Setup... command on the File 
menu.    As the default, Action! prints the objects in each scene at their Hold positions.    Otherwise, 
Action! prints the scene image if you specified it using the Set Preview command on the Scene menu

Copies:
Specifies the number of copies to print, from 1 to 99.

Scenes:
All

Prints all scenes in the presentation.
From

Prints a range of scenes, between 1 and 99.

Animation
Prints the presentation as it appears on the stage.

Scene Sorter
Prints a copy of the Scene Sorter.

Timeline
Prints a copy of the Timeline.

Content List
Prints a copy of the Content List.

Scenes per Page:
Specifies whether to print 1,2, or 4 scenes on each page.

No Background
When checked, Action! does not print scene or template backgrounds.    Action! prints faster with no 
backgrounds and with better clarity of other objects in the scene, especially if you are printing on a 
black and white printer.



Print To Video... Command

Creates a videotape of the current Action! presentation.    You must have an NTSC or PAL video card 
installed in your computer to print to videotape.    Before choosing this command, connect a videotape 
recorder to your computer's video output receptacle and press Record on the videotape recorder.    Wait
four seconds before clicking Print To Video in the dialog box.    You must press the recorder's Stop 
button when you are finished recording.

If your computer's screen saver is enabled, you may want to disable it using the Windows Control Panel
before choosing this command.    Otherwise, the screen saver may become active while printing is in 
progress.

Action! prints to video in Full Screen mode.    While printing to videotape, you have full control of the 
presentation.    You can start, stop, pause, or click built-in buttons in the presentation to control the 
sequence of scenes.



Exit Command

Quits Action!    If the current presentation has unsaved changes, Action! displays a dialog box asking 
you if you want to save the changes.



Undo/Redo Command

Undo reverses your last action in the active window and switches to Redo.    Redo cancels the effect of 
the Undo command.    Undo becomes Can't Undo if the last action cannot be reversed.



Cut Command

Removes one or more selected objects or scenes from the presentation and puts them on the 
Clipboard.    The object's attributes go with the object to the Clipboard.



Copy Command

Copies one or more selected objects or scenes to the Clipboard.    The object's attributes go with the 
object to the Clipboard.



Paste Command

Puts a copy of the Clipboard contents into the current scene, template, or selected text field at the 
current time.    Action! preserves all the attributes of objects when they are pasted. This command is 
unavailable if the Clipboard is empty.

Action! puts a pasted object in the top layer of the Timeline, so that it appears on top of all other objects 
in the scene or template.    Action! pastes the object with all its attributes, including Enter, Hold, and Exit 
settings, links, and attached sounds.    The pasted object's start time is relative to the current position of 
the playback head (the current scene time).



Paste Slide... Command

Pastes a slide from the Clipboard.

Import Options
Specifies how a slide is imported.
Import as One Metafile

Imports the slide in its original form.
Separate Text Only

Extracts the text from the slide, and makes the text items individual objects that you can assign 
action, sound, and links. The background remains in .WMF format..

Separate All Objects in Metafile
Separates the slide into its individual objects, which lets you apply separate actions to each object.

Insert Scene Options
Specifies where to insert the imported slide, which Action! treats as separate scene.

At Beginning
Inserts the slide at the beginning of the presentation.

After Current Scene
Inserts the slide s after the currently selected scene.

At End
Inserts the slide after the last scene in the presentation.



Delete Command

Removes the selection without putting it on the Clipboard.    If you accidentally delete something, 
immediately choose Undo from the Edit menu. (In the Edit menu for the Data Window, this command is 
called the Clear command.)



Select All Command

Selects all objects in the current window.    In the presentation window or in the Timeline, this command 
selects all objects in the window, regardless of their scene time.    This means that all objects are 
selected even if some of them are not currently visible in the presentation window.    In the scene sorter, 
choosing this command selects all scenes.    In the Content List, choosing this command selects all 
objects in the current scene.

If you only want to select those objects that are visible in the presentation window at the current time, 
drag across the objects or Shift-click to select them.



Paste Special... Command

Puts a copy of the Clipboard contents into the current scene or template, and lets you specify how to 
paste the time and other object attributes.    (This command is not applicable when pasting imported 
objects such as movies or sounds, or when pasting from another application.)

Time:
From Offset

Pastes objects using their original start time as an offset from the current scene time.    The offset is 
measured from the current position of the playback head.    If the object's original start time was two 
seconds after the scene's beginning, the pasted object's start time will be two seconds after the 
current position of the playback head.

From Now
Pastes objects at the current location of the playback head, ignoring the original start time of the 
objects.

Attributes:
All

Pastes objects with all their associated attributes.    If an object's duration is longer than the scene's 
duration, Action! lengthens the scene's duration to accommodate the object.

Static
Pastes objects preserving their static attributes (ink, color, content, hold, and duration) without 
transitions, motions, sounds, or links.



Clear Special... Command

Resets the time-related attributes of one or more selected objects.    For more information, select the 
name of a command.

Clear Dynamic
Clear Beginning To Now
Clear Now To End



Clear Special... Dynamic Command

Removes the transition, motion, Enter and Exit durations, sound, and link attributes from a selected 
object, but preserves the object's Hold duration and all other attributes (content, color, and ink).



Clear Special... Beginning To Now Command

Sets the start time of a selected object to the current scene time (the current location of the playback 
head in the Timeline).    Depending on the location of the playback head, this command may clear all or 
part of a selected object's Enter, Hold, or Exit phase.



Clear Special... Now To End Command

Shortens the duration of a selected object so that it ends at the current scene time (the current location 
of the playback head in the Timeline).    This command makes the object visible until the playback head 
reaches the current scene time.    This command is useful for creating a clean ending if you want 
several selected objects to leave the screen at the same time.



Duplicate Command

Creates a copy of one or more selected objects and places the copy near the original object.    You can 
then move the copy anywhere you want in the current scene or template.    When you duplicate an 
object, Action! adds the duplicate copy to the Timeline.    To stagger the appearance of several 
duplicates of an object in the scene, move the duplicate to a later time in the Timeline and then choose 
the Duplicate command again.    Action! offsets the new duplicate's Start Time in the Timeline.



Edit Object... Command

Displays the Edit Object dialog box, which allows you to edit a selected object's attributes.    The options
in the dialog box depend on the type of object selected when you choose this command.    Double-
clicking an object is a shortcut for choosing this command (except in compressed view).

To set the attributes of several objects at once, select the objects and choose this command.

For more information, select the name of an object.

Text
Graphic Object
Movie
Sound
Link



Edit Arc/Poly Command

Lets you change the shape of the selected arc or polygon.    This command appears as Edit Arc if an arc
is selected or as Edit Polygon if a polygon is selected.

Edit Arc Command
Handles appear at each endpoint of the selected arc.    Drag a handle to change the shape of the arc.    
To finish editing, click anywhere in presentation window.

Edit Polygon Command
Handles appear at each corner of the selected polygon.    Drag a corner to change the polygon's shape 
without affecting the other corners.    To finish editing, click anywhere in the presentation window.



Snap to Grid Command

When checked, aligns objects to an invisible grid when you create, move, or resize them.    Choose 
Snap to Grid again to uncheck the command in the menu and de-activate the grid.

Set the grid size using the Grid Dimensions option in the Preferences... command dialog box.

Use the arrow keys on your keyboard to move one or more selected objects by 1 pixel in the direction of
the arrow key you press.    If Snap to Grid is checked, pressing an arrow key moves the objects to the 
nearest grid point in the direction of the arrow key you press.



Preferences... Command

Choose or change settings that control some Action! operations.    For a new presentation, the 
Preferences dialog box displays the default values that Action! uses unless you change them.

Default Object Duration:
Sets the duration, in minutes and seconds, for all objects in the presentation.    You can set a different 
duration for an individual object using the Edit Object... command on the Edit menu.    The default 
duration for each object is 10 seconds.    This setting does not effect existing objects; it applies only to 
objects created or imported after you save the current presentation.

Default Scene Length:
Sets the scene length, in minutes and seconds, for all scenes in the presentation.    You can set a 
different duration for an individual scene using the Edit Scene... command on the Scene menu.    The 
default length for each scene is 1 minute.    This setting does not effect existing scenes; it applies only 
to scenes created after you save the current presentation.

Open In Compressed View
When checked, opens the presentation in compressed view, which allows you to view all scene and 
template objects in the current scene at the same time.    Objects appear at their Hold positions.

Load Templates in Compressed View
When checked, loads a template in compressed view when you use the Load Template command on 
the File menu.    This allows you to view all template objects at once.

Default Number of Scenes
Specifies the number of scenes Action! creates when you create a new presentation.    Changing this 
number does not affect the current presentation.    The default is 5 scenes.

Control Panel
Contains options for setting the Control Panel buttons.
Rew/FF:

Directly to Start/End
Sets Rewind and Fast Forward to rewind directly to the start or end of the scene.    This is the 
default.

Multiplier:
Sets the speed at which the Rewind and Fast Forward buttons operate.    The larger the number, 
the faster the rate.    By default, the buttons operate at a rate equal to 10 times normal speed.

Step Increment:
Sets the step increment, in milliseconds, for the Step and Backstep buttons.

Tab Every:
Sets the Tab key indent for text, in spaces, beginning at the text box's left margin.    This setting 
applies to all text in the presentation.    The default is 5 spaces.

Grid Dimensions
Specifies the invisible grid spacing, in pixels, used by the Snap To Grid command on the Edit menu.    
The default grid is 16 pixels high and 12 pixels wide.

Stage Size
Specifies the size of the area in which the presentation plays.    You can change the stage size to 
match the Windows monitor resolution.    Use this option if you plan to create a presentation on a 
monitor that has a different size or resolution from the monitor on which you will play the presentation.



Paste Link Command
Links cells in the Data Window to an external application. After a link is established, edits to data in the 
external application are automatically duplicated in the Data Window. You    cannot edit the linked cells 
directly in the Data Window. The link remains active as long as both applications remain open.

To link cells, 
1. Select cells in the external application.
2. Copy the cells to the Clipboard. 
3. Go to the Data Window and select the upper left cell of the group of cells you want to link.
4. Choose Paste Link from the Edit menu.



Insert Row/Col Command
Inserts an empty row or column into the Data Window. To insert a row, select the row below where you 
want the new row. To insert a column, select the column to the left of where you want the new column. 
Then choose Insert Row or Insert Col from the Edit menu.



Delete Row/Col Command
Deletes a row or column. To delete a row, select the row. To delete a column, select the column. Then 
choose Delete Row or Delete Col from the Edit menu.



Go To Cell... Command
Makes a specific cell active. In the dialog box, enter the column letter and row number for the cell you 
want.



Number Format... Command
Specifies the format used to display numbers in Data Window cells.    The chosen format is used only in 
the Data Window and does not appear in the chart. To specify a format for numbers that appear in the 
chart, use the Chart Options and Axis Options commands in the Chart menu.



Rewind Command

Rewinds to the beginning of the current scene, using the Rew/FF rate specified by the Preferences... 
command on the Edit menu.    This command is the same as clicking Rewind in the Control Panel.    You
can also drag the playback head to the left in the Timeline to rewind to a specific scene time.



Backstep Command

Moves backward in the current scene, using the step increment specified by the Preferences... 
command on the Edit menu.    The default backstep increment is 500 milliseconds (1/2 second).    This 
command is the same as clicking the backstep button in the Control Panel.    Press Ctrl+2 or click 
Backstep in the Control Panel to step backward one increment at a time.    Press and hold Ctrl+2, or 
press and hold Backstep in the Control Panel, to step continuously.



Stop Command

Stops playing the presentation.    This command is the same pressing Ctrl+3 or clicking the stop button 
in the Control Panel.



Step Command

Advances in the current scene, using the step increment specified by the Preferences... command on 
the Edit menu.    The default step increment is 500 milliseconds (1/2 second).    This command is the 
same as clicking the step button in the Control Panel.    Press Ctrl+4 or click step in the Control Panel to
step forward one increment at a time.    Press and hold Ctrl+4, or press and hold step in the Control 
Panel, to step continuously.



Play Command

Plays the presentation, beginning at the current scene time.    This command is the same as clicking the
play button in the Control Panel.



Fast Forward Command

Advances to the end of the current scene, using the Rew/FF rate specified by the Preferences... 
command on the Edit menu.    This command is the same as clicking the fast forward button in the 
Control Panel.    You can also drag the playback head to the right in the Timeline to fast forward to a 
specific time.



Play Presentation Command

Plays the presentation using the entire screen, with all windows and menus hidden, beginning from the 
first scene.    While the presentation plays, you can access the Action! menus by dragging the mouse 
pointer along the top edge of the screen.

To pause the presentation, press the spacebar.    Press the spacebar again to resume.    

To stop the presentation, press Ctrl+3, choose Stop from the Control menu, or press Esc.



Zoom In Command

Enlarges the time scale in the Timeline.    You see less of the scene, but in greater detail with respect to 
the placement of objects in time.    Choose this command repeatedly to enlarge the time scale further, 
up to 10-second increments.    This command is the same as clicking the "+" icon at the bottom of the 
Timeline.    It is available only when the Timeline window is open.



Zoom Out Command

Reduces the time scale in the Timeline.    You see more of the scene, which is useful for getting an 
overview of the placement of objects in time.    Choose this command repeatedly to reduce the time 
scale further, up to 30-minute increments.    This command is the same as clicking the "-" icon at the 
bottom of the Timeline.    It is available only when the Timeline window is open.



Set Loop... Command

Creates a repeated action in the current scene.    You can set more than one loop in the Timeline.

Start Time:
Type the loop start time or click the arrows to set it.

End Time:
Type the loop end time or click the arrows to set it.

To create a loop, press Ctrl-Shift and click on where in the Timeline you want to set the loop. You can 
also create a loop by rewinding the scene to its beginning, playing the scene, and then clicking Stop in 
the Control Panel when the playback head reaches the location where you want to start the loop.    Then
choose Set Loop... from the Control menu.    The Start Time value in the Set Loop dialog box reflects 
the location of the playback head.    Click the End Time to change it to the end time for the loop.    Click 
OK to set the loop in the Timeline.

Action! inserts start and end loop markers in the Timeline to mark the loop.    When the playback head 
reaches the start loop marker, Action! repeats the scene within the loop.    Drag a loop marker in the 
Timeline to change the start or end time of the loop.    

To delete a loop, drag the markers down into Timeline, or double-click a loop marker to display the Edit
Loop dialog box and then click Delete.

To continue from a loop, use the link tool to create a button within the loop and assign an action to it.



Set Pause... Command

Sets a pause in the current scene and inserts a pause marker in the Timeline.    You can set more than 
one pause in a scene.    When the presentation plays, Action! pauses the presentation when the 
playback head reaches the pause marker in the Timeline.    To continue the presentation, press the 
spacebar.    Pausing the presentation also pauses any sound that may be playing at the time of the 
pause.    When you resume, Action! resumes playing the sound.

Use this command to pre-set a pause in your presentation.    You can also pause your presentation at 
any time during playback by pressing the spacebar.    Press the spacebar again to resume.

Time:
Type, or click the arrows to set the time at which you want the pause to occur.

To set a pause, Ctrl-click where in the Timeline you want to set a pause.    You can also set a pause by 
rewinding the scene to its beginning, playing it, and then clicking Stop in the Control Panel when the 
playback head reaches where you want to insert a pause.    Then choose Set Pause... from the Control 
menu.    The Time value in the Set Pause dialog box indicates the location of the playback head.    Click 
OK to set the pause.

To change when the pause starts, drag a pause marker in the Timeline.    

To delete the pause, drag the marker down into the Timeline, or double-click the pause marker to 
display the Edit Pause dialog box and then click Delete.



Scene View Command

When checked, displays the scene objects in the current scene at the current time, so you can move or 
edit them, or create new objects.    Scene view also displays template objects, but you cannot move or 
edit them.    

To edit a template object in scene view, select the template and then convert it to a scene object by 
choosing Promote To Scene from the Object menu.    You can cut, copy, paste, delete, and duplicate 
template objects in scene view.    If you cut or copy and then paste a template object in scene view, 
Action! converts it to a scene object.    If you cut or delete a template object in scene view, it still appears
in template view and in all other scenes that use the same template.    The changes you make to 
template objects in scene view are not reflected in the template itself or in other scenes that use the 
same template.

Some objects may not be visible in scene view if the current scene time is different from the objects' 
duration time.



Template View Command

When checked, displays the template objects associated with the current scene at the current time, so 
you can move or edit them, or create new objects.    To identify template view, Action! displays a 
template view icon in each corner of the window.    Scene objects are grayed.    Note that some objects 
are not visible in template view if the scene time is different from the object's duration time.    To make 
sure that template objects do not unexpectedly disappear before the end of a scene, you should assign 
very long durations to all template objects.    Make the object durations are longer than the duration of 
the longest scene to which the template will be applied.

If you modify a template object in template view, the changes are reflected in all scenes that use the 
current template.



Compressed View Command

When checked, displays all scene and template objects at their Hold positions, ignoring their start and 
end times and durations.    To identify compressed view, Action! displays a compressed view icon in 
each corner of the window.

By default, Action! opens presentations and loads templates in compressed view.    If you want to 
change this default, use the Preferences... command on the Edit menu.

Compressed View is useful for checking the location of all scene and template objects in the current 
scene.    You can move scene objects so that they will appear in the desired location even though they 
may have different scene times.    Compressed View is also useful for editing objects, since you can 
view all the objects at the same time.    You can edit, move, align, and group scene objects.    You cannot
move template objects in compressed view, but you can cut, copy, paste, and delete them.    Double-
click text to edit it.    Double-click an imported graphic to display the Import dialog box, so you can 
replace it with another graphic.

Choosing this command is the same as checking the compressed view check box in the Control Panel.  
If you uncheck this box, click a Control Panel button, or choose a tool from the tool palette, Action! 
returns the presentation to scene view.    Keep in mind that when you leave Compressed view, some 
objects may disappear if their scene times do not match the current scene time.



Timeline Command

When checked, displays the Timeline window, which shows the time and layer relationships for all 
scene and template objects in the current scene.    The Timeline arranges objects from left to right 
according to their start times.    The Timeline arranges objects from top to bottom according to their 
layer, so that the top-most object appears in front of all other objects in the scene or template (except 
for any template objects that you have brought to the front using the Bring To Front command on the 
Object menu).    The only exception is a movie object, which appears in front of all other objects in the 
presentation window, regardless of its location in the Timeline.

Scene objects appear above template objects in the Timeline.    The boundary between them is 
indicated by a thick gray horizontal line.    In Template view, the Timeline only shows template objects.

Each object is represented by a horizontal bar.    Action uses a different bar color for each type of object.
The bar's length indicates the object's scene duration.      The bar's left edge represents the object's 
Enter time; the bar's right edge represents the object's Exit time.    The object's Hold duration is 
delimited by two vertical lines inside the bar.    The left-most vertical line indicates the start of the Hold 
phase; the right-most vertical line indicates the end of the Hold phase.

To change the Timeline scale, click the + or - icon to enlarge or reduce the time scale.    Double-click 
the + or - icon to zoom the time scale all the way in or out.    You can also choose a scale from the pop-
up list between the + and - icons.

To move to a new scene time, drag the playback head left or right.

To move a loop marker or pause marker, drag the marker.    To edit a marker, double-click it to display
the Edit Loop or Edit Pause dialog box. To delete a    marker, drag the marker down into the Timeline 
and release the mouse button.

To move an object to a new time, select the object and drag it horizontally.

To change the object's layer, select the object and drag it vertically.    In the presentation window, an 
object in a higher layer appears in front of an object in a lower layer if the objects overlap.

To change an object's Enter duration, select the object and drag its left edge.

To change an object's Hold duration, select the object and drag one of the vertical lines that's inside 
the bar.    Drag toward the end of the object to increase Hold duration; drag toward the center of the 
object to decrease Hold duration.

To change an object's Exit duration, select the object and drag its right edge.

To change an object's Enter, Hold, and Exit durations proportionally, select the object and hold 
down the Shift key while dragging the object's right or left edge, or one of the vertical lines inside the 
bar.

To change an object's attributes, double-click it to display the Edit Object dialog box.

To edit an object, select it and choose a command from the Edit menu.

To apply a link, sound, or action to an object, select the Link, Sound, or Action Tool in the Tool 
Palette and then click the object.



Scene Sorter Command

When checked, displays the Scene Sorter, which lets you add, delete, or rearrange scenes.    The 
Scene Sorter displays the compressed view image of all scenes in the presentation.    For each scene, 
Action! displays the name of the scene and its associated template.

Action! displays icons between scenes to indicate the scene's IN Transition and At End Of Scene 
settings, as specified in the scene's Edit Scene dialog box.    Action! displays a sound icon between 
scenes if an object's sound continues playing into the next scene, as specified in the object's Edit 
Object dialog box or Sound Edit dialog box.

Setting for At End of Scene Icon displayed
in Edit Scene dialog box                 in scene sorter  
Skip (or Go) to Next Scene right arrow
Skip (or Go) to Previous Scene left arrow
Skip (or Go) to Scene S# or G#, where # is

the destination
scene number

Replay Current Scene circular arrow
Return down left arrow
Stop stop sign

A solid border encloses the current scene.    Choosing a command from the Object or Scene menu 
affects the current scene.    A dotted-line border frames the selected scene. Choosing a command from 
the Edit menu affects the selected scene.

To change the scene image displayed in the Scene Sorter, use Set Preview on the Scene Menu.

To make a scene the current scene, click the left or right scene arrows in the Control Panel.

To select a scene, click it.

To add a new scene, choose New Scene from the Scene menu.    Action! adds the new scene after the
current scene.

To insert a new scene, choose Insert Scene... from the Scene menu.    You can insert a scene at the 
beginning of the presentation, after the current scene, or at the end of the presentation.

To select more than one scene, hold down the Shift key while you click additional scenes.

To de-select a scene, hold down the Shift key and click the scene.

To reorder a scene, select it and drag it to the new location.

To edit a scene, select it and choose a command from the Edit menu.

To change a scene's settings, double-click it to display the Edit Scene dialog box.

To edit a scene's template, select the scene and choose Edit Template... from the Scene menu.

To apply a different template to the scene, select the scene and choose Edit Scene... from the Scene
menu.

To delete a scene, select it and choose Delete from the Edit menu.



Content List Command

When checked, displays the Content List window, which lists the names of all scenes in the 
presentation and all the objects in each scene.    Use the Content List as you would use an outline, to 
review or rearrange the order of scenes in your presentation.    You can create, delete, or reorder 
scenes, add objects to scenes, edit the names of scenes and objects, and add new objects to scenes.    
Action! lists objects in their start time order in the scene.    Since the Content List doesn't take into 
account the layering of objects, objects might not be in the same order as they appear in the Timeline.

Action! displays an outline box around the current scene's icon.    Choosing a command from the Object 
or Scene menus affects the current scene.    Action! highlights the selected scene.    Choosing a 
command from the Edit menu affects the selected scene.

To make a scene the current scene, click the left or right scene arrows in the Control Panel, choose 
the scene from the scene list in the Control Panel, or use the Scene List command on the Scene menu.

To select a scene, click the scene's icon or Shift-click to select multiple scenes.

To select an object, click the object's icon, or Shift-click to select multiple objects in the same scene.

To create a new scene, choose New Scene from the Scene menu.    Action! adds the new scene after 
the last scene, and makes it the current scene.

To create a new object in the current scene, choose New Object from the Object menu.

To insert a scene, choose Insert Scene... from the Scene menu.    You can insert a scene at the 
beginning of the presentation, after the current scene, or at the end of the presentation.

To cut, copy, or paste an object in the current scene; select it and choose the appropriate command
from the Edit menu.

To rename a scene or object, select the name and type a new name.    You should assign unique 
names to your scenes and objects to help identify them.

To move a scene or object, drag its icon to the new location.    You can move objects within or 
between scenes.    Moving an object up or down within a scene changes its start time.    The change is 
reflected in the Timeline.

To change the current scene's attributes, choose Edit Scene... from the Scene menu.

To collapse or expand a scene's object list, double-click the scene's icon.



Control Panel Command

When checked, displays the Control Panel, which allows you to control the current scene, preview it, 
and play the presentation.    Use the Preferences... command on the Edit menu to set the behavior for 
the Rewind, Fast Forward, Step, and Backstep buttons.

To minimize the Control Panel, click the minimize box at the top right corner of the Control Panel to 
display just the control buttons.    Click it again to display the full Control Panel.

To advance or reverse the scene time, drag the slider to the right or left, or click the time to change it.

To display all objects in the current scene or template, click the compressed view checkbox.    
Action! displays all objects in the current scene or template at their Hold positions, without regard to 
their scene times.    Checking this box is the same as choosing Compressed View from the Control 
menu.

To make a different scene the current scene, click the scene name to display a list of all scenes in 
the presentation, and choose a name from the list to make it the current scene.

To display the next or previous scene, click the left or right arrow.

To display the first or last scene, double-click the left or right arrow.



Tool Palette Command

When checked, displays the Tool Palette, which provides tools for creating text, objects, and buttons, 
adding sounds or movies, applying actions, and for choosing colors, patterns, and line styles for text 
and drawn objects.    Action! creates new objects at the current scene time.

If you use the right mouse button to select a tool (except for the text tool), that tool remains selected 
until you choose another tool.    If you select a tool using the left mouse button, Action! reselects the 
pointer tool after you finish with the current tool.

pointer
Click this tool to reposition, resize, or select objects.    To select more than one object, Shift-click 
objects to add them to the selection, or drag across objects to select many at once.    When you drag 
the pointer across objects, Action! selects objects that fall entirely within the selection rectangle.    To 
select objects that intersect the selection rectangle, press Ctrl while dragging.    To re-size an object 
proportionally, press Shift while resizing it.    To apply an object's attributes to another object, first 
select the object that has the attributes you want to change.    Then Ctrl-click the object that has the 
attributes you want to apply.    Action! applies the attributes of the object you Ctrl-click to the object 
you first selected.    To apply an object's attributes to the Tool Palette, Ctrl-click the object.    Action! 
changes the Tool Palette's color, outline, and pattern palettes, and the line sample to match the 
object.

text tool
Click this tool, then click (or drag to create a bounding box of the desired width) in the presentation 
window and type to create text.    To change text attributes or color, select the text and choose a 
command from the Text menu, or choose a color from the color chip in the Tool Palette.

drawing tools
Click the rectangle, polygon, rounded rectangle, oval, line, or arc tool and drag in the presentation 
window to create an object.    To create a square or circle, select the rectangle or oval tool and then 
press Shift while dragging.

chart tool
Click and drag the cursor in the presentation window to create a chart. A sample chart, the Chart 
Gallery, and the Data Window appear.

To edit chart data, use the Data Window. To change the chart format, choose a new format from the 
Chart Gallery. To change color, labeling, grids or line style, use the Chart Options and Axis Options 
commands. 

You can also use the chart tool to select and change parts of an existing chart. To change the color 
and color and line settings of labels and title text, select the chart tool and then click the label or title. 
Then use the line and color tools in the Tool Palette or Text menu commands to change the titles. To 
change grid lines, select the chart tool from the Tool Palette and then use the line and color tools in 
the Tool Palette to change the grid lines.

To change the color of the walls and floor in a 3D chart, select the chart tool and then click the item. 
Then use the color tool to change the color.

color chip
Click to display the color palette, so you can change the color of the selected object or text. 

Click the upper left corner of the chip to display the palette for the fill color. If the object has a pattern, 
click the lower right corner to display the palette for the second color in the pattern. 
Click the line below the chip to display the palette for border colors.



pattern sample
Click to choose a different pattern.    Double-click to change the pattern colors, or to choose a different
pattern palette.

line sample
Click to choose a different line width.    Double-click to change the line width or line style.

action tool
Click to apply action to an object or import a Macromedia Director movie into the current scene or 
template.    To apply action to an object, select the action tool and then click the object to display the 
Apply Action dialog box.    To import a Director movie, click the action tool and then click anywhere in 
the presentation window to display the Import dialog box.

sound tool
Click to apply a sound to an object or to the current scene or template.    To assign a sound to an 
object, click this tool and then click the object.    To assign a sound to the current scene or template, 
click this tool and then click anywhere in the presentation window.    The Import dialog box appears so
you can choose the sound.    When you click Import in this dialog box, Action! displays the Sound Edit 
dialog box so you can specify the sound's duration (and for an object, cue the sound to the object's 
Enter, Hold, or Exit phase).    If you import a CD Audio sound, click the CD Audio button to display the 
CD Audio Editor dialog box.    Use this dialog box to create the CD Audio segment.    To create the 
segment, specify a start time and track number, and an end time and track number.    When you click 
OK, Action! returns you to the Sound Edit dialog so you can specify the sound's duration.

Note that you must have a sound card installed in your computer to play sounds in an Action! 
presentation.    To play CD sounds, you must have a compact disc player attached to your computer.

link tool
Click to make an object into a button or create a new button.    To make an object into a button, click 
the link tool and click the object to display the Create Link dialog box.    To create a new button, click 
the link tool and then click anywhere in the presentation window to display the Create Button dialog 
box.



Full Screen Command

When checked, displays the presentation window using the entire screen, and hides the menu bar and 
any other open windows.    This command gives you the same viewing area as when you choose Play 
Presentation from the Control menu.    To get access to the menus, drag the pointer along the top edge 
of the screen.    To cancel this view, press Esc or Alt+W,F, or choose Full Screen again from the Window
menu.



New Object Command

Creates a placeholder for a new object in the current scene or template, and in the Timeline and 
Content List.    For more information, choose an object from the list.

Text
Graphic
Sound
Movie
Button



New Object Text Command

Creates a new, empty text object at the current time in the current scene or template.    Choosing this 
command is the same as using the text tool in the Tool Palette.    After choosing this command, type the 
text you want the object to contain.



New Object Graphic Command

Creates a placeholder for an imported graphic at the current time in the current scene or template.    
Action! creates a graphic object placeholder with handles in the presentation window    (as well as in the
Timeline and Content List).    To import a graphic image, double-click the placeholder in the scene or in 
the Timeline to display the Edit Object dialog box.    Choose Content from the drop-down list, and then 
click the grey content replacement button to open the Import dialog box.



New Object Sound Command

Creates a placeholder for a sound at the current time in the current scene.    Action! displays the sound 
placeholder only in the Timeline and the Content List, and not the scene.    To import a sound, open the 
Timeline or Content List and double-click the sound placeholder to display the Edit Object dialog box.    
Click the grey content replacement button in the Edit Object dialog box to display the Import dialog box. 
Choose the sound you want and click Import.    Action! displays the Sound Edit dialog box so you can 
specify the sound's duration.    If you import a CD Audio sound, click the CD Audio button to display the 
CD Audio Editor dialog box.    Use this dialog box to create the CD Audio segment.    To create the 
segment, specify a start time and track number, and an end time and track number.    When you click 
OK, Action! returns you to the Sound Edit dialog so you can specify the sound's duration.

Action! can play only one .WAV, one.MID, or one CD Audio sound at a time, but it can play .WAV, .MID, 
and CD Audio sounds with each other. For example. you can play one .WAV    and one CD Audio sound,
but you cannot play two CD audio sounds at the same time.

You must have a sound card installed in your computer to play sounds in an Action! presentation.    To 
import CD audio, you must have a CD player connected to your computer.



New Object Movie Command

Creates a placeholder for an imported movie at the current time in the current scene or template.    
Action! displays the movie placeholder in the presentation window and in the Timeline and Content List. 
To import a movie, double-click the movie placeholder to display the Edit Object dialog box.    Click the 
grey content replacement button in the dialog box to open the Import dialog box.    Action! imports 
Macromedia Director movies that have first been converted on the Macintosh using the Gaffer in 
Macromedia Windows Player.

A movie plays on top of all other objects in the scene, regardless of its position in the Timeline.    You 
may need to reposition or crop the movie's playback area in order to see other objects in the scene.    
You can reposition the movie by selecting it and dragging it.    To crop the movie's playback area, drag 
one of its selection handles.    You cannot cut, copy, paste, or duplicate a movie.



New Object Button Command

Creates a new button placeholder at the current time in the current scene, and displays the button 
placeholder in the Timeline and Content List.    Double-click the button placeholder to display the Edit 
Object dialog box so you can choose its attributes and assign a link.    Choosing this command is the 
same as using the link tool in the Tool Palette.



Group Command

Combines selected objects into a single object.    Grouped objects can be manipulated as a single 
object.    Grouped objects can be grouped again to form part of a larger group.    To change individual 
objects in a group, you must first ungroup them using the Ungroup command on the Object menu.

Because a grouped object occupies only one channel in the Timeline, grouping objects reduces the 
number of objects in the Timeline, and makes working in the Timeline more manageable.    Grouping 
objects is also useful for manipulating a complex drawing, to preserve the alignment of objects when 
you move them, and for editing the attributes of several objects at once.

You can assign attributes to a grouped object as if it were a single object.    The attributes of individual 
objects in the group are preserved (except for color, line style, and hold position) when you group them.



Ungroup Command

Breaks a grouped object into its individual objects, reversing the effect of the Group command.    If a 
grouped object consists of several grouped objects, you may have to choose this command more than 
once to separate individual objects.    Attributes you assigned to a grouped object are lost when you 
ungroup the object.    Each individual object in the group reverts to the attributes it had before it was 
grouped (except for color, line style, and hold position).



Explode Metafile Command

Separates a selected metafile into individual graphic objects that can be edited or animated.    You can 
paste a metafile into Action! from another Windows application, or import a metafile using Import... on 
the File menu.    Metafile images often consist of objects that you may want to manipulate using Action!. 
When you choose this command, Action! separates the metafile into individual objects, with all of them 
selected.    Click in the presentation window to de-select the objects.    You can then select an individual 
object and double-click it to display the Edit Object dialog box so you can choose or change its 
attributes.    Objects in an exploded metafile can be modified like any other Action! objects.



Align Objects... Command

Aligns selected objects vertically, horizontally, or centered with respect to each other.    Before choosing 
this command, select the objects that you want to align.    Choosing this command displays a dialog box
that lets you choose the alignment for the selected objects.

Based on the alignment option you choose in the dialog box, Action! uses one of the selected objects as
the object to which the other objects align.    For example, if you have three objects selected and you 
choose one of the left alignment options, Action! aligns the objects to the left-most object in the 
selection.



Synchronize Objects... Command
When the Timeline is active, synchronizes the entrance times of selected objects. The top object in the 
Timeline enters first. Entrance times for subsequent objects are offset from the time of this object. 

Start All Objects Together 
Has all objects start at the same time.

Start Each Object When 
Sets an object's enter time relative to the action of the previous object.

Stagger Objects By 
Inserts additional time after the event specified in Start Object When and before the object enters. 



Bring To Front Command

Moves selected objects to the frontmost layer in the current scene or template.    An object in the 
frontmost layer appears in front of all other objects that it overlaps.

If you choose this command for a template object, the object appears in front of any scene objects that 
it overlaps.    Bringing a template object to the frontmost layer is useful for objects like buttons or 
company logos that you never want to have appear behind other objects in a scene.

When you create an object, Action! assigns it to the frontmost layer.    To see the relationship between 
objects and their layers, open the Timeline.    Choosing the Bring To Front command is the same as 
dragging an object to the top layer in the Timeline.    Note that a movie object always appears in front of 
all other objects in the presentation window, regardless of its location in the Timeline.



Send To Back Command

Moves selected objects to the backmost layer in the current scene or template.    Objects in the 
backmost layer appear behind all other objects, just in front of the background.

When you create an object, Action! assigns it to the frontmost layer.    To see the relationship between 
objects and their layers, open the Timeline.    Choosing the Send To Back command is the same as 
dragging an object to the bottom layer in the Timeline.    Note that a movie object always appears in 
front of all other objects in the presentation window, regardless of its location in the Timeline.



Move Forward Command

Moves selected objects forward one layer in the current scene or template.    Choosing this command is 
the same as dragging selected objects up one layer in the Timeline.



Move Back Command

Moves selected objects back one layer in the current scene or template.    Choosing this command is 
the same as dragging selected objects down one layer in the Timeline.



Show/Hide Template Objects Command

Displays or hides all template objects in the current scene.    If you cut or delete a template object in the 
current scene, the Show Template Objects command causes the object to reappear in the scene.



Show/Hide Scene Objects Command

Displays or hides all scene objects in the current scene.



Promote To Scene Command

In scene view, converts one or more selected template objects into scene objects that you can edit in 
the current scene.    You must select the template objects in scene view before choosing this command. 
This command does not alter the template in any way - it simply hides the template object in the scene 
after converting it to a scene object.    To see the original template object, choose Show Template 
Objects on the Object menu.    Use this command to make changes to a template object in the current 
scene without affecting the template.



Font Command

Applies the chosen font to selected text.    Your choice affects selected text as well as text to be typed.    
The fonts that are available depend on the fonts that are installed under Windows.    You can add or 
remove fonts and printer drivers through the Windows Control Panel.



Size Command

Applies the chosen point size to selected text.    Your choice affects selected text as well as text to be 
typed.    The sizes that are available depend on the fonts that are installed under Windows.    You can 
add or remove fonts and printer drivers through the Windows Control Panel.

If you have installed a font manager such as Adobe Type Manager or TrueType (if your computer is 
using Windows 3.1), fonts can appear in whatever point size you choose. To specify a point size that 
isn't in the list, choose Other from the Size list and enter the exact point size you want in the dialog box.I



Style Command

Applies the chosen style to selected text.    Your choice affects selected text as well as text to be typed.



Alignment Command

Aligns selected text with the left or right edge of the text box, or centers the text within the text box.    
Left alignment is the default.    Your choice affects selected text as well as text to be typed.



Border Command

Applies the chosen border thickness to the box that encloses selected text.    By default, the text border 
is set to "None."    Your choice affects selected text as well as text to be typed.



New Scene Command

Adds a new scene after the last scene, and makes it the current scene.    Action! assigns the new scene
the same template as the scene you were in when you chose this command.    Action! assigns the new 
scene a default name which consists of the word "Scene" followed by a sequential number.    To change 
the scene's name, enter the new name in the Content List or use the Edit Scene... command on the 
Scene menu.



Insert Scene... Command

Inserts one or more new scenes into the presentation at the location you specify, and lets you choose a 
template to apply to the scenes.

Insert Scenes
Enter the number of new scenes you want to insert.
At Beginning

Inserts the new scenes before the first scene.
After Current Scene

Inserts the new scenes after the current scene.
At End

Inserts the new scenes after the last scene.

Template:
Lists the templates loaded with the current presentation.    Action! applies the chosen template to the 
new scenes.



Edit Scene... Command

Lets you choose or change the settings for the current scene.

Name:
Displays the name of the current scene.    To rename the scene, edit the text or delete it and type the 
new name.    It's important to name your scenes, since the default scene names (Scene 1, Scene 2, 
etc.) can be misleading if you rearrange the order of your scenes in the scene sorter.

Duration:
Displays the scene's entire duration, in minutes and seconds.    To change the duration, type the new 
time or drag the slider.

Scale %:
Displays the rate at which the scenes plays.    At 100%, the scene plays at the normal rate.    At 50% 
the scene plays in half the normal time, or twice as fast as normal.    At 200% the scene plays in twice 
the normal time, or twice as slow as normal.    To play the scene at a different rate, enter a new Scale 
factor.    Action! adjusts the Play Time to match the new rate.

Play Time:
Displays the length of time you want the scene to play.    Normally, the Play Time and Duration are the
same.    However, if you want the scene to play within a specific amount of time, enter a new Play 
Time.    Action! automatically adjusts the play rate (Scale%) to match the Play Time you enter.

Palette:
Displays the name of the current palette and lists the palettes you can apply to the current scene.    If 
the scene's palette is different than the current template's palette, Action! uses the scene's palette.

Template:
Displays the name of the current template and lists the templates you can apply to the current scene.

IN Transition:
Displays the name of the current scene transition effect and lists the available transition effects. The 
IN Transition occurs before the scene time begins. If the scene's IN Transition is different from the 
current template's IN Transition (as specified using the Edit Template... command on the Scene 
menu) Action! uses the scene's IN Transition.    Note that if the current scene is the first scene, Action!
ignores this setting, since you cannot have a transition effect before the first scene.    To see the IN 
Transition effect assigned to a scene, open the Scene Sorter.    Action! displays an icon between 
scenes to identify the scene's IN Transition effect.

IN Duration:
Displays the IN transition's duration in minutes and seconds. To change the IN duration, type the new 
time or drag the slider. 

At End Of Scene:
Displays the name of the action that occurs at the end of the current scene, and lists the actions that 
you can apply.    Use Go to Scene if you want to go to another scene and then return from that scene 
to the current scene.    (The scene you go to must have a Return action specified for its "At End Of 
Scene" option.)    Use Skip to Scene if you want to change locations from the current scene to another
scene.        To see the action assigned to the end of a scene, open the Scene Sorter.    Action! uses an 
icon between scenes to identify the scene's At End Of Scene setting.

Snap Duration to Last Object
When checked, sets the scene duration to the end of the last object in the scene. If the duration of 
objects in the scene changes, the scene duration changes by the same amount.



Scene:
Lists destination scenes you can specify if Go to Scene or Skip to Scene is chosen for the "At End Of 
Scene" option.



Edit Template... Command

Lets you choose or change template settings for the current template.    These settings apply to all 
scenes that use the current template.    To override any of the template settings for an individual scene, 
make it the current scene and choose Edit Scene... on the Scene menu.

Name:
Displays the name of the current template that is applied to the current scene.

Palette:
Displays the name of the template palette.    This palette is applied to all scenes that use the current 
template.    You can choose a different palette for an individual scene using Edit Scene... on the 
Scene menu.

IN Transition:
Displays the name of the current template IN Transition effect and lists the available transition effects. 
The IN Transition occurs before the scene time begins, and determines how a template transitions 
into the presentation.    The transition effect takes 10 seconds between scenes to complete.    You can 
choose a different IN Transition for an individual scene using Edit Scene... on the Scene menu.



Set Background... Command

Lets you choose a background color, pattern, gradient, or graphic for the current scene or template.    To
set a background for the scene, you must be in scene view when you choose this command.    To set a 
background for the template, you must be in Template view when you choose this command.    If the 
template and scene both have backgrounds, Action! uses the scene's background.    Action! does not 
display the background in the Timeline.    It is always the back-most layer.

None
Specifies no background for the current scene or template, and removes the current background.

Pattern
Displays the pattern sample and the foreground and background color chips, so you can choose a 
combination for the pattern.

Gradient
Displays a list of gradient styles and lets you choose a color combination using the foreground and 
background color chips. 
Use Palette
When checked, gives a smoother gradient by creating a new palette that has 64 chips reserved for 
the gradient colors. To keep the gradient the same, you must continue to use the new gradient palette
in the scene. If you want to assign colors to objects in the scene, check Use Palette first, and then 
assign colors from the new gradient palette.

Graphic
Click Load... to import a Windows bitmap graphic (.DIB or .BMP) file to use as the background.



Delete Unused Template... Command

Deletes any templates that are not applied to scenes in the presentation.    Action! removes the unused 
templates from the presentation but does not delete the template files on disk.    Unused templates 
remain with the presentation until you choose this command.    If you create and replace templates 
frequently, use this command to free unused memory and enhance performance.

Click Delete to remove the template listed in the dialog box.    Click Delete All to remove all templates in 
the list.



Next Scene Command

Displays the next scene.    Choosing this command is the same as clicking the right scene arrow in the 
Control Panel.



Previous Scene Command

Displays the previous scene.    Choosing this command is the same as clicking the left scene arrow in 
the Control Panel.



Set Preview Command

Uses the image in the current scene at the current scene time for the image that appears in the scene 
sorter and in any dialog boxes that have a Preview button.    If there is a distinctive object in the scene, 
set the scene time so that it is visible and then choose this command.    If you want to use a preview 
image that shows all objects in the current scene, choose this command while displaying the scene in 
compressed view.



Scene List Command

Displays a list of all scenes in the current presentation, so you can move easily between scenes.    
Choosing this command is the same as choosing the scene from the scene list in the Control Panel.



Gallery Command

Displays a gallery of formats that you can choose to plot a chart.

Type: 
Lists the chart types you can choose from.

Plot
Plots data in    the chosen format.

To display chart formats, choose a type from the Type drop-down list. Icons representing formats for 
that chart type appear in the gallery.    

To choose a chart format, click on the appropriate icon. A description of the format appears to the right
of the Type box. 

To change a chart format, click the icon for the format you want, and then click Plot.



Data Window Command

Lets you enter, edit, copy, or paste chart data and text. The Data Window also assigns roles such as 
data range, series names, category names, or axis subtitle text to specific cells. Use the chart items 
drop-down list, Set, and Show buttons to see or change a cell's role.

Chart items drop-down list
Lists possible roles for Data Window cells.

Set:
Assigns selected cells a specific role in the chart. To assign a role to cells, select the cells, and 
choose the new role from the chart items drop-down list. Then click Set.

Show:
Shows which cells have the role listed in the chart item box. For a data range, the selected cells are
highlighted. For series names, category names, and axis titles, the appropriate cells are highlighted 
and the cell address and content are displayed. To see which cells have a specific role, choose the 
role you are interested in from the chart items drop-down list, then click Show.

Plot
Plots a chart from the contents of the Data Window. Action! uses only the data cells included in the 
data range to plot a chart.

You can set also set the data range by using the Plot button. To set the data range this way, select 
the cells you want in the range, then click Plot. The selected cells become the new data range.

To select cells, click an individual cell or drag across adjoining cells. You can also select an entire 
row or column by clicking the letter for the column or the number for the row.

To display a chart item, select the item from the chart item box. Then click Show.

To set the data range, select the cells you want to include in the data range, choose data range from
the chart items drop-down list, and then click Set.

To edit data, select a cell, then edit the cell in the cell edit line. Select a new cell or press Return to 
enter the new data. 



Data Motion... Command

Sets the enter, hold, and exit attributes for data series or categories. Use the additional menu to choose 
whether to set attributes for series or categories. Use the drop-down list at the top of the dialog box to 
choose the series or categories you want to set attributes for.

Enter
Opens the enter dialog box. 
Transition: 

Lists the available enter transitions.
Motion:

Lists the available enter motions.
Duration:

Specifies how    long each series or category takes to enter.
Stagger Objects By:

Inserts the specified time between the entrance of each object in the group.
Start Enter When: 

Sets the entrance time relative to an action of the previous series or category.
Delay:

Inserts the specified time between the event selected in the Start Enter When box 
and the start of the series.

Hold
Opens the hold dialog box. 
Duration: 

Specifies the length of time when all series or categories are holding together. If 
there is no time when all groups hold on the stage together, specifies the hold 
duration for individual series or categories.

Hold until chart ends:
Has the selected series or categories hold until the ends. 

Pause When All Series Have Entered
When checked, sets a pause after all series or categories have entered.

Pause When Each Data Object Has Entered
When checked, sets a pause after each data object has entered.

Pause When Each Series Has Entered
When checked, sets a pause after each series or category has entered.

Exit
Opens the exit dialog box.

Transition: 
Lists the available exit transitions.

Motion:
Lists the available exit motions.

Duration:
Specifies how    long each series or category takes to exit.

Stagger Objects By:
Inserts the specified time between the exit of each object in the series or category.

Start Exit When: 
Sets the exit time relative to an action of the previous series or category.

Delay:
Inserts the specified time between the event selected in Start Exit When and when 
the series exits.



Chart Options... Command

Displays the Chart Options dialog box, which lets you specify many aspects of a chart's appearance. 
The dialog box    for pie charts is different than the dialog box    for bar, line, and area charts. 

For bar, area, and line charts, the dialog box has these options:

Show Data Values:
When checked, displays data values on each data object.

Data Value Format:
If Show Data Values is checked, lists the available numerical formats. 

Chart Orientation:
Specifies whether to plot the chart vertically or horizontally. 

Data Layout:
Specifies how to display data within a category .

Stacked Data:
When checked, stacks data objects on top of each other. This is mostly useful for bar and area 
charts.

Absolute Data:
When checked, plots each data object from the X-axis. If data objects overlap in an area chart, 
smaller values are hidden if they are behind larger values. This is mostly useful for line charts and 
side-by-side bar charts.

As Percentages
When checked, shows each data item as a percentage of the total in each category. This is only 
available if Stacked Data is selected.

Marker Style
Specifies the style of data marker used in a line chart. Choose    the series you are assigning data 
markers to from the left box.    Choose the marker style to use for that series from the right box. 

Show Shadows:
When checked, displays shadows behind data objects.

Show Legend:
When checked, displays the legend describing series names on the chart.

For pie charts, the dialog box has these options:

Show Data Values:
When checked, displays the data value for each pie slice.

Data Value Format:
If Show Data Values is checked, lists the formats for data value displays.

Show Data Labels:
When checked, displays the data label for each pie slice.
Inside

Places data values and data labels within the pie slice.
On the Edge

Places data values and data labels against the edge of the pie slice.
Outside

Places data values and data labels outside the pie slice, and connects the value to the slice with 
a leader.

Data Layout:
Data layout is not available for pie charts.

Marker Style
Marker Style is not available for pie charts.

Show Shadows:
When checked, displays shadows behind pie slices.



Show Legend:
When checked, displays a legend describing series names.



Axis Options... Command

Displays the Axis Options dialog box, which allows you to set many attributes of the X and Y axes on bar, 
line, and area charts.

Axis attributes drop-down list
Sets which axis to set attributes for.

Axis Value:
Specifies how the axis is labeled.

Show Axis Labels:
When checked, displays labels on the axis.

Data Format:
Lists the available formats for the axis labels.

Axis Scale:
Specifies whether the axis is linear or logarithmic. 
Linear

Specifies a linear scale. 
Logarithmic 

Specifies a logarithmic scale.

Tick marks drop-down list
Sets whether to set attributes for major or minor tick marks. Major tick marks indicate larger intervals. 
Minor tick marks indicate smaller intervals between major tick marks.

Show Tick Marks
When checked, displays tick marks on the axis.
Inside

Places tick marks inside the chart.
Outside

Places tick marks outside the chart.
Crossing

Places tick marks across the axis.

Show Major Grid
When checked, displays a grid for the selected axis. You can display major grids only. 

Show Axis Title
When checked, displays the axis title.



Perspective... Command

Displays the Perspective dialog box, which allows you to select a viewing angle and zoom factor    for 
3D bar charts. 

Gallery
Shows a gallery of icons that represent available chart viewing angles. Click    the icon that represents
the perspective you want. 

Show Left Wall
When checked, displays a left wall behind a 3D bar chart.

Show Right Wall
When checked, displays a right wall behind    a 3D bar chart.

Zoom:
Lists zoom options, which enlarge or shrink data objects in the chart.    Zoom In enlarges the data 
objects. Zoom out shrinks the data objects 



Commands... Command

Displays the Action! command index, so you can get help on any Action! command.    Choosing this 
command is the same as pressing F1 from within Action! or clicking the Contents button in the Action! 
Help window.



Using Help... Command

Displays the introductory topic on how to access and use Windows Help.



About Action!... Command

Displays the Action! version number, copyright notice, and credits.



Text Object Attributes

For a selected text object, the Edit Object dialog box lists the following attributes:

Enter Apply transition and motion effects as the text enters the scene, and specify the Enter 
duration.

Hold Specify the Hold duration, and choose a light effect and duration.

Exit Apply transition and motion effects as the text exits the scene, and specify the Exit 
duration.

Duration Specify the text object's duration in the scene, and the start time.

Content Choose or change font, size, style, alignment, and border.

Color Choose fill color, alternate pattern color, border, pattern, and line style.

Ink and ShadowChoose ink and shadow effects for text objects.

Sound Attach a sound to text, cue it for playback, and specify sound duration and loop options.

Link Assign action, sound, and highlight to a text link.



Graphic Object Attributes

For a selected graphic object (drawn using the Action! Tool Palette or imported from another 
application), the Edit Object dialog box lists the following attributes:

Enter Apply transition and motion effects as the object enters the scene, and specify the Enter 
duration.

Hold Specify the Hold duration, and choose a light effect and duration.

Exit Apply transition and motion effects as the object exits the scene, and specify the Exit 
duration.

Duration Specify the object's duration in the scene, and the start time.

Content Choose or change object type, origin, and extent.

Color Choose fill color, alternate pattern color,border, pattern, and line style.

Ink and ShadowChoose ink and shadow effects for drawn objects.

Sound Attach a sound to the object, cue it for playback, and specify sound duration and loop 
options.

Link Assign action, sound, and highlight to an object link.



Movie Object Attributes

For a selected movie object, the Edit Object dialog box lists the following attributes:

Enter Apply transition and motion effects as the movie enters the scene, and specify the Enter 
duration.

Hold Specify the Hold duration, and choose a light effect and duration.

Exit Apply transition and motion effects as the movie exits the scene, and specify the Exit 
duration.

Duration Specify the movie's duration in the scene, and the start time.

Content Choose or change object type, origin, and extent.

Link Assign action, sound, and highlight to a movie link.

Movie Info Specify how the movie plays in the scene.



Sound Object Attributes

For a selected sound object, the Edit Object dialog box lists the following attributes:

Sound Specify sound duration and loop options.



Link Object Attributes

For a selected link object, the Edit Object dialog box lists the following attributes:

Enter Apply transition and motion effects as the object enters the scene, and specify the Enter 
duration.

Hold Specify the Hold duration, and choose a light effect and duration.

Exit Apply transition and motion effects as the object exits the scene, and specify the Exit 
duration.

Duration Specify the button's duration and start time in the scene.

Content Choose a button shape.

Color Choose button color, border, pattern, and line style.

Ink and ShadowChoose an ink and shadow effect.

Sound Attach a sound to the object, cue it for playback, and specify sound duration and loop 
options.

Link Assign action, sound, and highlight to a link object.
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Transition:
Lists the transitions Action! can apply to the text as it enters the scene.

Motion:
Lists the motions Action! can apply to the text as it enters the scene.    Start/End or Path Editor let you 
define the text's motion as it enters the scene.    For a summary of the steps for using Start/End and 
Path Editor, see below.

Duration:
Specifies the length of the Enter phase, in seconds.    Action! adds the enter duration to the object's 
total duration.

To use Start/End,
1. In scene or template view, place the object at its hold position.
2. In the Object Editor dialog box, choose Start/End from the Motion drop-down list.    The view changes

to allow you to specify the object's motion.
3. Drag the duration slider to specify the duration of the object's motion.
4. Drag the object to its starting position.    A duplicate image of the object appears.    A connecting line 

indicates the direction of motion.
5. Click Done.    The Edit Object dialog box reappears.
6. Click OK.    To review the object's motion, use the Control Panel to rewind and play the scene.

To use Path Editor,
1. In scene or template view, place the object at its Hold position.
2. In the Object Editor dialog box, choose Path Editor from the Motion drop-down list.    The view 

changes to allow you to specify the object's motion.
3. Drag the object to the location where you want the motion to begin.    A duplicate image of the object 

appears at the new location.
4. Drag the duration slider to set the duration of the first segment of the object's motion.
5. Drag the duplicate image of the object to a new location.    A connecting line indicates the direction of

motion.
6. Repeat Steps 4 and 5 until all segments of the path are defined.    Be sure that the last position of the

duplicate object is directly on top of its Hold position.    Otherwise, the object will appear to hop to its 
Hold position, rather than moving smoothly.

7. Click Done.    The Edit Object dialog box reappears.
8. Click OK.    To review the object's motion, use the Control Panel to rewind and play the scene.
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Duration:
Specifies the length of the Hold phase, in seconds.

Light Effect
Duration:

Lists the light effects Action! can apply to text.    The light effect starts at the beginning of the Hold 
phase, and continues for the specified duration.    Specify the light effect color using the color 
palette.
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Transition:
Lists the transitions Action! can apply to the text as it leaves the scene.

Motion:
Lists the motions that Action! can apply to the text as it leaves the scene.  Start/End or Path Editor let 
you define the text's motion.    For a summary of steps for using Start/End and Path Editor, see below.

Duration:
Specifies the length of the Exit phase, in seconds.    Action! adds the Exit duration to the object's total 
duration.

To use Start/End,
1. In scene or template view, place the object at its hold position.
2. In the Object Editor dialog box, choose Start/End from the Motion drop-down list.    The view changes

to allow you to specify the object's motion.
3. Drag the duration slider to specify the duration of the object's motion.
4. Drag the object to its ending position.    A duplicate image of the object appears.    A connecting line 

indicates the direction of motion.
5. Click Done.    The Edit Object dialog box reappears.
6. Click OK.    To review the object's motion, use the Control Panel to rewind and play the scene.

To use Path Editor,
1. In scene or template view, place the object at its hold position.
2. In the Object Editor dialog box, choose Path Editor from the Motion drop-down list.    The view 

changes to allow you to specify the object's motion.
3. Drag the duration slider to set the duration of the first segment of the object's motion.
4. Drag the object to a new location.    A duplicate image of the object appears.    A connecting line 

indicates the direction of motion.
5. Repeat Steps 3 and 4 until all segments of the path are defined.
6. Click Done.    The Edit Object dialog box reappears.
7. Click OK.    To review the object's motion, use the Control Panel to rewind and play the scene.
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Duration:
Specifies the total time the text appears in the scene.    Action! adds the Start, Hold, and Exit durations
to determine the total duration.    If you increase this number, Action! increases the Hold duration.    If 
you decrease this number, Action! decreases the Hold duration.    If Action! must decrease the Hold 
duration to zero, then the Enter and Exit durations are shortened by equal amounts.

Start Time:
Specifies the start time offset, measured from the beginning of the scene, at which the text first 
appears in the scene.



Return to Text Attributes
Text Content Options 5 of 9

The options display the text attributes of the first character in the selected text block.

Font:
Lists the available fonts that are in your installed printer driver.

Size:
Lists the available point sizes.    If a size is not available, Action! uses the nearest available size.    If 
you have installed a font manager like Adobe Type Manager, Action! uses whatever point size you 
choose.

Alignment:
Lists the alignment options for text within its bounding box.

Style:
Lists the text styles.    You can choose any combination of bold, italic, and underline.

Border:
Lists the border thicknesses for the text bounding box.
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Foreground:
Displays the color chip, so you can choose text colors. Click the upper left corner and drag in the 
palette to choose a fill color. Click the lower right corner and drag in the palette to choose a second 
color for the pattern, if    any.

Background:
Displays the background color chip, so you can choose a color for the text's bounding box.

Pattern:
Not available for text.

Line Style:
Lists the line styles for the text's bounding box.
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Lists the ink and shadow effects that Action! can apply to text.    Experiment with different ink and 
shadow effects to find the one you want.    Some ink and shadow effects give different results when 
working in color rather than black and white, some effects work well with patterns, while others work 
better with solid colors.    Copy and White Transparent do not effect text.    Transparent makes the 
background of a pattern transparent, so that you can see objects underneath, and works best with 
patterns.    Reverse reverses overlapping colors, and works with patterns or solid colors.    Ghost 
makes text appear white.
When checked, Show Shadow includes a second image of the text behind and offset from the initial 
text. Click the color chip and drag to select a shadow color. 
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Sound name
Displays the file name of the sound that is attached to the selected text.    Click to display the Import 
dialog box to attach a different sound.

Loop
When checked, Action! repeats the sound until the end of the text's duration in the scene.    When not 
checked, the sound plays once.    Since digitized sounds require a lot of memory, using the loop 
option saves memory by letting you repeat a short sound instead of using a longer sound that 
requires more memory.

Duration:
Specifies the length of time that the sound plays.    If the sound's duration is longer than the scene's 
duration, Action! stops playing the sound at the end of the scene (unless Continue Into Next Scene is 
checked).

Cue
Cues the sound for playback during the phase you specify.
Delay

Specifies a delay, if you don't want the sound to start at the beginning of the specified phase.

Continue Into Next Scene
When checked, the sound continues playing into the next scene, acting as a transition to the next 
scene.    This setting does not actually lengthen the sound's duration.    You must set the sound's 
duration so that it is long enough to continue playing into the next scene.    When not checked, Action! 
stops playing the sound when the scene ends.    This feature lets you continue playing a sound while 
Action! loads the contents of the next scene.
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Action:
Displays the current action applied to the text object, and lists all the actions.    If you use a "Go to" 
option, you can include a "Return" option in the destination scene to return to the time and location 
where the "Go to" was issued.    Use a "Skip to" option if you don't want to return.

Destination
Available for Go to Link and Skip to Link actions only.
Scene:

Specifies the name of the destination scene.
Time:

Specifies an offset time from the beginning of the destination scene.

Sound:
Displays the current sound to play when the text link is used. You can play WAVE, MIDI, or CD audio 
when the text is clicked.

Highlight
When checked, highlights text link when used.
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Transition:
Lists the transitions Action! can apply to the object as it enters the scene.

Motion:
Lists the motions Action! can apply to the object as it enters the scene.    Start/End or Path Editor let 
you define the object's motion.    For a summary of the steps for using Start/End and Path Editor, see 
below.

Duration:
Specifies the length of the Enter phase, in seconds.    Action! adds the Enter duration to the object's 
total duration.

To use Start/End,
1. In scene or template view, place the object at its Hold position.
2. In the Object Editor dialog box, choose Start/End from the Motion drop-down list.    The view changes

to allow you to specify the object's motion.
3. Drag the duration slider to specify the duration of the object's motion.
4. Drag the object to its starting position.    A duplicate image of the object appears.    A connecting line 

indicates the direction of motion.
5. Click Done.    The Edit Object dialog box reappears.
6. Click OK.    To review the object's motion, use the Control Panel to rewind and play the scene.

To use Path Editor,
1. In scene or template view, place the object at its Hold position.
2. In the Object Editor dialog box, choose Path Editor from the Motion drop-down list.    The view 

changes to allow you to specify the object's motion.
3. Drag the object to the location where you want the motion to begin.    A duplicate image of the object 

appears at the new location.
4. Drag the duration slider to set the duration of the first segment of the object's motion.
5. Drag the duplicate image of the object to a new location.    A connecting line indicates the direction of

motion.
6. Repeat Steps 4 and 5 until all segments of the path are defined.    Be sure that the last position of the

duplicate object is directly on top of its Hold position.    Otherwise, the object will appear to hop to its 
Hold position, rather than moving smoothly.

7. Click Done.    The Edit Object dialog box reappears.
8. Click OK.    To review the object's motion, use the Control Panel to rewind and play the scene.
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Duration:
Specifies the length of the Hold phase, in seconds.

Light Effect
Duration:

Lists the light effects Action! can apply to objects.    The light effect starts at the beginning of the 
Hold phase, and continues for the specified duration.    Specify the light effect color using the color 
palette.
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Transition:
Lists the transitions Action! can apply to the object as it leaves the scene.

Motion:
Lists the motions that Action! can apply to the object as it leaves the scene.    Start/End or Path Editor 
let you define the object's motion.    For a summary of the steps for using Start/End and Path Editor, 
see below.

Duration:
Specifies the length of the Exit phase, in seconds.    Action! adds the Exit duration to the object's total 
duration.

To use Start/End,
1. In scene or template view, place the object at its Hold position.
2. In the Object Editor dialog box, choose Start/End from the Motion drop-down list.    The view changes

to allow you to specify the object's motion.
3. Drag the duration slider to specify the duration of the object's motion.
4. Drag the object to its ending position.    A duplicate image of the object appears.    A connecting line 

indicates the direction of motion.
5. Click Done.    The Edit Object dialog box reappears.
6. Click OK.    To review the object's motion, use the Control Panel to rewind and play the scene.

To use Path Editor,
1. In scene or template view, place the object at its Hold position.
2. In the Object Editor dialog box, choose Path Editor from the Motion drop-down list.    The view 

changes to allow you to specify the object's motion.
3. Drag the duration slider to set the duration of the first segment of the object's motion.
4. Drag the object to a new location.    A duplicate image of the object appears.    A connecting line 

indicates the direction of motion.
5. Repeat Steps 3 and 4 until all segments of the path are defined.
6. Click Done.    The Edit Object dialog box reappears.
7. Click OK.    To review the object's motion, use the Control Panel to rewind and play the scene.
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Duration:
Specifies the total time the object appears in the scene.    Action! adds the Start, Hold, and Exit 
durations to determine the total duration.    If you increase this number, Action! increases the Hold 
duration.    If you decrease this number, Action! decreases the Hold duration.    If Action! must 
decrease the Hold duration to zero, then the Enter and Exit durations are shortened by equal 
amounts.

Start Time:
Specifies the start time offset, measured from the beginning of the scene, at which the object first 
appears in the scene.
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Type:
Displays the type or name of the selected object.    If you imported the object or created it using New 
Object Graphic on the Object menu, Action! displays a button you can click to open the Import dialog 
box.    This allows you to import a graphic object to replace the selected one.

Origin
Displays the x and y coordinates of the upper left corner of the object, relative to the upper left corner 
of the screen. 

Extent:
Displays the x (width) and y (height) coordinates of the object's bounding box.
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Foreground:
Displays the fill and pattern color chip. Click the upper left corner and drag in the palette to choose a 
fill color. Click the lower left corner and drag in the palette to choose an alternate color for patterns.

Background:
Displays the background color chip, so you can choose a color for the object's border.

Pattern:
Displays the pattern sample, so you can choose a fill pattern.

Line Style:
Lists the line styles for the object's border.
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Lists the ink and shadow effects that Action! can apply to graphic objects.    You may have to 
experiment with different ink and shadow effects to find the one you want.    Some ink effects have a 
different effect when working in color rather than black and white, some effects work well with 
patterns, while others work better with solid colors.    Copy and White Transparent do not affect 
graphic objects.    Transparent makes the background of a pattern transparent, so that you can see 
objects underneath, and works best with patterns.    Reverse reverses overlapping colors, and works 
with patterns or solid colors.    Ghost makes objects appear white.
When checked, Show Shadow displays a shadow behind the graphic object. Click the color chip and 
drag in the palette to choose a shadow color.
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Sound name
Displays the file name of the sound that is attached to the selected object.    Click to display the Import
dialog box to attach a different sound.

Loop
When checked, Action! repeats the sound until the end of the object's duration in the scene.    When 
not checked, the sound plays once.    Since digitized sounds require a lot of memory, using the loop 
option saves memory by letting you repeat a short sound instead of using a longer sound that 
requires more memory.

Duration:
Specifies the length of time that the sound plays.    If the sound's duration is longer than the scenes' 
duration, Action! stops playing the sound at the end of the scene (unless Continue Into Next Scene is 
checked).

Cue
Cues the sound for playback during the phase you specify.
Delay

Specifies a delay, if you don't want the sound to start at the beginning of the specified phase.

Continue Into Next Scene
When checked, the sound continues playing into the next scene, acting as a transition to the next 
scene.    This setting does not actually lengthen the sound's duration.    You must set the sound's 
duration so that it is long enough to continue playing into the next scene.    When not checked, Action! 
stops playing the sound when the scene ends.    This feature lets you continue playing a sound while 
Action! loads the contents of the next scene.
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Action:
Displays the current action applied to the object, and lists all the actions.    If you use a "Go to" option, 
you can include a "Return" option in the destination scene to return to the time and location where the
"Go to" was issued.    Use a "Skip to" option if you don't want to return.

Destination
Applies only for Go to Link and Skip to Link actions.
Scene:

Specifies the name of the destination scene.
Time:

Specifies an offset time from the beginning of the destination scene.

Sound:
Displays the current sound to play when the graphic link is used. You can play WAVE, MIDI, or CD 
audio when the graphic link is clicked.

Highlight
When checked, highlights the graphic link when used. 
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Transition:
Transitions are ignored for movie objects.

Motion:
Lists the motions Action! can apply to the movie as it enters the scene.    Start/End or Path Editor let 
you define the movie's motion.    For a summary of the steps for using Start/End and Path Editor, see 
below.

Duration:
Specifies the length of the Enter phase, in seconds.    Action! adds the Enter duration to the object's 
total duration.

To use Start/End,
1. In scene or template view, place the object at its Hold position.
2. In the Object Editor dialog box, choose Start/End from the Motion drop-down list.    The view changes

to allow you to specify the object's motion.
3. Drag the duration slider to specify the duration of the object's motion.
4. Drag the object to its starting position.    A duplicate image of the object appears.    A connecting line 

indicates the direction of motion.
5. Click Done.    The Edit Object dialog box reappears.
6. Click OK.    To review the object's motion, use the Control Panel to rewind and play the scene.

To use Path Editor,
1. In scene or template view, place the object at its Hold position.
2. In the Object Editor dialog box, choose Path Editor from the Motion drop-down list.    The view 

changes to allow you to specify the object's motion.
3. Drag the object to the location where you want the motion to begin.    A duplicate image of the object 

appears at the new location.
4. Drag the duration slider to set the duration of the first segment of the object's motion.
5. Drag the duplicate image of the object to a new location.    A connecting line indicates the direction of

motion.
6. Repeat Steps 4 and 5 until all segments of the path are defined.    Be sure that the last position of the

duplicate object is directly on top of its Hold position.    Otherwise, the object will appear to hop to its 
Hold position, rather than moving smoothly.

7. Click Done.    The Edit Object dialog box reappears.
8. Click OK.    To review the object's motion, use the Control Panel to rewind and play the scene.
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Duration:
Specifies the length of the Hold phase, in seconds.

Light Effect
Duration:

Lists the light effects Action! can apply to movies.    The light effect starts at the beginning of the 
Hold phase, and continues for the specified duration.    Specify the light effect color using the color 
palette.
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Transition:
Transitions are ignored for movie objects.

Motion:
Lists the motions that Action! can apply to the movie as it leaves the scene.    Start/End or Path Editor 
let you define the movie's motion.    For a summary of the steps for using Start/End and Path Editor, 
see below.

Duration:
Specifies the length of the Exit phase, in seconds.    Action! adds the exit duration to the object's total 
duration.

To use Start/End,
1. In scene or template view, place the object at its Hold position.
2. In the Object Editor dialog box, choose Start/End from the Motion drop-down list.    The view changes

to allow you to specify the object's motion.
3. Drag the duration slider to specify the duration of the object's motion.
4. Drag the object to its ending position.    A duplicate image of the object appears.    A connecting line 

indicates the direction of motion.
5. Click Done.    The Edit Object dialog box reappears.
6. Click OK.    To review the object's motion, use the Control Panel to rewind and play the scene.

To use Path Editor,
1. In scene or template view, place the object at its Hold position.
2. In the Object Editor dialog box, choose Path Editor from the Motion drop-down list.    The view 

changes to allow you to specify the object's motion.
3. Drag the duration slider to set the duration of the first segment of the object's motion.
4. Drag the object to a new location.    A duplicate image of the object appears.    A connecting line 

indicates the direction of motion.
5. Repeat Steps 3 and 4 until all segments of the path are defined.
6. Click Done.    The Edit Object dialog box reappears.
7. Click OK.    To review the object's motion, use the Control Panel to rewind and play the scene.
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Duration:
Specifies the total time the movie appears in the scene.    Action! adds the Start, Hold, and Exit 
durations to determine the total duration.    If you increase this number, Action! increases the Hold 
duration.    If you decrease this number, Action! decreases the Hold duration.    If Action! must 
decrease the Hold duration to zero, then the Enter and Exit durations are shortened by equal 
amounts.

Start Time:
Specifies the start time offset, measured from the beginning of the scene, at which the movie first 
appears in the scene.



Return to Movie Attributes
Movie Content Options 5 of 7

Displays the name of the movie object.    To replace the movie, click the button to open the Import dialog
box.

Origin
Displays the x and y coordinates of the upper left corner of the movie, relative to the upper left corner 
of the screen. 

Extent:
Displays the x (width) and y (height) coordinates of the movie's bounding box.
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Action:
Displays the current action applied to the movie, and lists all the actions.    If you use a "Go to" option, 
you can include a "Return" option in the destination scene to return to the time and location where the
"Go to" was issued.    Use a "Skip to" option if you don't want to return.

Destination
Applies only for Go to Link and Skip to Link actions.
Scene:

Specifies the name of the destination scene.
Time:

Specifies an offset time from the beginning of the destination scene.

Sound:
Displays the current sound to play when the movie link is used. You can play WAVE, MIDI, or CD 
audio when the movie link is clicked.

Highlight
When checked, highlights the movie link when used.
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Movie tempo and length are determined when the movie was created in Macromedia Director.    Action! 
cannot control the movie's tempo.    You can shorten the movie's play time by shrinking it in the Timeline
or by specifying a shorter duration.

Loop
When checked, Action! repeats the movie if it is shorter than the movie object's duration in the scene. 
When not checked, the movie plays once.

Leave Last Frame
When checked, displays the movie's last frame until the end of the movie object's duration in the 
scene.    If the scene duration is shorter than the movie's duration, choosing this option uses the 
movie as a transition into the next scene.

Movie Sound
When checked, the movie plays with its original sound.    If you attached a sound using the Movie 
Sound option, Action! overrides it and plays the movie's original sound.
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Sound name
Displays the sound's file name.    Click to display the Import dialog box to import a different sound.

Loop
When checked, Action! repeats the sound until the end of the sound's duration in the scene.    When 
not checked, the sound plays once.    Since digitized sounds require a lot of memory, using the loop 
option saves memory by letting you repeat a short sound instead of using a longer sound that 
requires more memory.

Duration:
Specifies the length of time that the sound plays.    If the sound's duration is longer than the scenes' 
duration, Action! stops playing the sound at the end of the scene (unless Continue Into Next Scene is 
checked).

Delay:
Specifies a delay, measured from the scene's start time, if you don't want the sound to start at the 
beginning of the scene.

Continue Into Next Scene
When checked, the sound continues playing into the next scene, acting as a transition to the next 
scene.    This setting does not actually lengthen the sound's duration.    You must set the sound's 
duration so that it is long enough to continue playing into the next scene.    When not checked, Action! 
stops playing the sound (truncates it) when the scene ends.    This feature lets you continue playing a 
sound while Action! loads the contents of the next scene.
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Transition:
Lists the transitions Action! can apply to the object as it enters the scene.

Motion:
Lists the motions Action! can apply to the object as it enters the scene.    Start/End or Path Editor let 
you define the object's motion.    For a summary of the steps for using Start/End and Path Editor, see 
below.

Duration:
Specifies the length of the Enter phase, in seconds.    Action! adds the Enter duration to the object's 
total duration.

To use Start/End,
1. In scene or template view, place the object at its Hold position.
2. In the Object Editor dialog box, choose Start/End from the Motion drop-down list.    The view changes

to allow you to specify the object's motion.
3. Drag the duration slider to specify the duration of the object's motion.
4. Drag the object to its starting position.    A duplicate image of the object appears.    A connecting line 

indicates the direction of motion.
5. Click Done.    The Edit Object dialog box reappears.
6. Click OK.    To review the object's motion, use the Control Panel to rewind and play the scene.

To use Path Editor,
1. In scene or template view, place the object at its Hold position.
2. In the Object Editor dialog box, choose Path Editor from the Motion drop-down list.    The view 

changes to allow you to specify the object's motion.
3. Drag the object to the location where you want the motion to begin.    A duplicate image of the object 

appears at the new location.
4. Drag the duration slider to set the duration of the first segment of the object's motion.
5. Drag the duplicate image of the object to a new location.    A connecting line indicates the direction of

motion.
6. Repeat Steps 4 and 5 until all segments of the path are defined.    Be sure that the last position of the

duplicate object is directly on top of its Hold position.    Otherwise, the object will appear to hop to its 
Hold position, rather than moving smoothly.

7. Click Done.    The Edit Object dialog box reappears.
8. Click OK.    To review the object's motion, use the Control Panel to rewind and play the scene.
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Duration:
Specifies the length of the Hold phase, in seconds.

Light Effect
Duration:

Lists the light effects Action! can apply to objects.    The light effect starts at the beginning of the 
Hold phase, and continues for the specified duration.    Specify the light effect color using the color 
palette.
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Transition:
Lists the transitions Action! can apply to the object as it leaves the scene.

Motion:
Lists the motions that Action! can apply to the object as it leaves the scene.    Start/End or Path Editor 
let you define the object's motion.    For a summary of the steps for using Start/End and Path Editor, 
see below.

Duration:
Specifies the length of the Exit phase, in seconds.    Action! adds the Exit duration to the object's total 
duration.

To use Start/End,
1. In scene or template view, place the object at its Hold position.
2. In the Object Editor dialog box, choose Start/End from the Motion drop-down list.    The view changes

to allow you to specify the object's motion.
3. Drag the duration slider to specify the duration of the object's motion.
4. Drag the object to its ending position.    A duplicate image of the object appears.    A connecting line 

indicates the direction of motion.
5. Click Done.    The Edit Object dialog box reappears.
6. Click OK.    To review the object's motion, use the Control Panel to rewind and play the scene.

To use Path Editor,
1. In scene or template view, place the object at its Hold position.
2. In the Object Editor dialog box, choose Path Editor from the Motion drop-down list.    The view 

changes to allow you to specify the object's motion.
3. Drag the duration slider to set the duration of the first segment of the object's motion.
4. Drag the object to a new location.    A duplicate image of the object appears.    A connecting line 

indicates the direction of motion.
5. Repeat Steps 3 and 4 until all segments of the path are defined.
6. Click Done.    The Edit Object dialog box reappears.
7. Click OK.    To review the object's motion, use the Control Panel to rewind and play the scene.
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Duration:
Specifies the total time the button appears in the scene. 

Start Time:
Specifies the start time offset, measured from the beginning of the scene, at which the button first 
appears in the scene.
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Style:
Displays the current button shape and lists all the shapes.
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Foreground:
Displays the foreground color chip. Click the upper left corner of the chip and drag in the palette to 
choose a fill color. Click the lower right corner and drag in the palette to choose an alternate color for 
patterns. 

Background:
Displays the background color chip so you can choose a color for the button's border.

Pattern:
Displays the pattern sample, so you can choose a fill pattern.

Line Style:
Lists the line styles for the button's border.
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Lists the ink and shadow effects that Action! can apply to objects.    You may need to experiment with 
different ink and shadow effects to find the one you want.    Some ink effects have a different effect 
when working in color rather than black and white, some effects work well with patterns, while others 
work better with solid colors.    Copy and White Transparent do not affect graphic objects.    
Transparent makes the background of a pattern transparent, so that you can see objects underneath, 
and works best with patterns.    Reverse reverses overlapping colors, and works with patterns or solid 
colors.    Ghost makes objects appear white.
When checked, Show    Shadow    displays a shadow behind the link object. Click the color chip and 
drag in the palette to choose a shadow color.
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Sound name
Displays the file name of the sound that is attached to the selected object.    Click to display the Import
dialog box to attach a different sound.

Loop
When checked, Action! repeats the sound until the end of the object's duration in the scene.    When 
not checked, the sound plays once.    Since digitized sounds require a lot of memory, using the loop 
option saves memory by letting you repeat a short sound instead of using a longer sound that 
requires more memory.

Duration:
Specifies the length of time that the sound plays.    If the sound's duration is longer than the scenes' 
duration, Action! stops playing the sound at the end of the scene (unless Continue Into Next Scene is 
checked).

Cue
Cues the sound for playback during the phase you specify.
Delay

Specifies a delay, if you don't want the sound to start at the beginning of the specified phase.

Continue Into Next Scene
When checked, the sound continues playing into the next scene, acting as a transition to the next 
scene.    This setting does not actually lengthen the sound's duration.    You must set the sound's 
duration so that it is long enough to continue playing into the next scene.    When not checked, Action! 
stops playing the sound when the scene ends.    This feature lets you continue playing a sound while 
Action! loads the contents of the next scene.
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Action:
Displays the current action applied to the button, and lists all the actions.    If you use a "Go to" option,
you can include a "Return" option in the destination scene to return to the time and location where the
"Go to" was issued.    Use a "Skip to" option if you don't want to return.

Destination
Applies only for Go to Link and Skip to Link actions.
Scene:

Specifies the name of the destination scene.
Time:

Specifies an offset time from the beginning of the destination scene.

Sound
Displays the current sound to play when the link is used. You can play WAVE, MIDI, or CD audio 
when the link object is clicked.

Highlight
When checked, highlights the link when used.



scroll bar

A bar that appears at the right and/or bottom edge of a window whose contents aren't completely visible.   
Each scroll bar contains two scroll arrows and a scroll box which allow you to scroll within the window.



compressed view

Both scene and template objects are shown at their Hold positions.    Compressed view allows you to see 
all objects in the scene, without regard to their scene time.




